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1 Overview 

This manual provides instructions for specification writers contributing to the State of 

Wyoming's 2010 edition of the Department of Transportation’s Standard Specifications for 

Road and Bridge Construction and supplemental specifications. The information included 

here constitutes the department’s approved guidelines for matters of writing style, word and 

number usage, and formatting. 

 

Questions not addressed here should be answered by consulting The Chicago Manual of 

Style, 16
th

 Edition, the United States Government Printing Office Style Manual, 2008, any 

specialized sources cited within, or a recent standard dictionary of American English. 

 

All examples cited in this Guide are simply models for style, usage, formatting, etc. They are 

not actual specifications or portions thereof, so do not consider them to be or use them as 

such. 

 

Word processing instructions in this Guide are written for Microsoft Office Word 2007. 

Users of other versions of Word should see their respective user’s manuals. 

 

Purpose of the Revision 

The department revises its Standard Specifications periodically, having done so most 

recently in 2010. This revision includes special provisions and supplemental specifications that 

have been written or revised since the book’s 2003 edition. The 2010 Standard Specifications 

also continues to employ changes made starting with the 2003 book, which included providing 

specifications in both the inch-pound units of U.S. customary measure and in the International 

System of Units (abbreviated as SI and known commonly in the United States as the metric 

system). All dimensions are given in inch-pound units first, followed by SI counterparts in 

brackets. The provision of dual units is intended to help ensure that Standard Specifications are 

kept current for metric, as well as U.S. customary, should the need arise to produce a metric job. 

 

The 2010 book also continues to use a writing style meant to improve clarity and promote 

consistency as well as clearly identify the roles and responsibilities of all the parties involved in a 

contract. 

 

Benefits of the Active Voice and Imperative Mood 

Among the writing tools used to enhance clarity in the Standard Specifications is the use of 

both the active voice and the imperative mood. 
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These grammatical terms will be explained fully in section 9, Wording of Specifications, of 

this Guide. But in brief, the active voice forces a writer to identify within a sentence who is 

responsible for what. A sentence in the passive voice that might have said (as it did in the 

1996 edition):  

 

If invoices for transportation charges are not furnished, payment will be delayed until the 

invoices are submitted. 

 

In the active voice, it might instead say: 

 

The department will withhold payment for transportation charges until the contractor 

submits the invoices. 

 

Not only does the second sentence have 18 percent fewer words than the first, but it also adds 

two pieces of information:  who is responsible for the delay in payment (the department) and 

who is responsible for submitting the invoices (the contractor). Used well, the active voice 

adds clarity, identifies responsibility, and lessens a reader’s burden by simplifying sentence 

structure and eliminating words. 

 

The imperative mood offers similar benefits. It is the most efficient way to give a command, 

direction, or instruction. The imperative allows brevity because the person to whom the 

instruction is addressed is understood grammatically to be included in the sentence but is left 

out of the wording. Because the imperative is the language of efficient direction, it is often 

found in cookbooks, where it is understood but unstated that the instructions in the book are 

directed to the cook: 

 

Heat the pan. Add some oil. Crack two eggs. Flip once. Make some coffee. Enjoy your 

breakfast. 

 

Unless otherwise indicated, such statements in Standard Specifications are directed to the 

bidder or the contractor. Increased use of the imperative gives specification writers a tool to 

make this direction more efficient. 

 

To demonstrate and take advantage of the benefits of using the imperative mood, this Guide 

uses this style with specification writers as the audience. 
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2 Organization of Specifications 

Hierarchy of Organization 

Use the following hierarchy when writing the elements of a specification; use only as many 

sublevels as are needed: 

 

 000 Three-digit section number 

 000.0 Subsection-1, one or two digits, as necessary 

 

Except in Division 100, General Provisions, and Division 800, Materials, 

these digits are reserved for designating parts 1 through 5 of the 

department’s five-part format; i.e., for the subsection titles ―Description,‖ 

―Materials,‖ etc. 

 

 000.0.0 Subsection-2, one or two digits, as necessary 

 000.0.0.0 Subsection-3, one or two digits, as necessary 

 

Basic Elements 

Except for sections in Division 100, General Provisions, and Division 800, Materials, the 

basic elements of a specification (with 000 representing the section number) are: 

 

000.1 Description 

000.2 Materials 

000.3 Equipment 

000.4 Construction 

000.5 Measurement and Payment 

 

Format 

1
 For section numbers and titles, use bolded Arial type and all capitals. Type subsection 

numbers and titles in bolded Arial type but with only the first letter of all significant words 

capitalized. Place section and subsection titles on separate lines above their following text. 

Do not put a period after the last digit of a section or subsection number or after the title. 

 
2 

Number each paragraph within a subsection, starting with the numeral 1; begin renumbering 

with each new subsection. Paragraph numbers will be placed in the left-hand margin, as 
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shown in the examples at the beginning of this and the previous paragraph, during final 

formatting for Standard Specifications book revisions. 

 

When referencing paragraph numbers for revision or replacement, follow the example below: 

 

 SS-400A 
Page 4 of 55 

 

 

WYOMING DEPARTMENT OF TRANSPORTATION 
 

SUPPLEMENTARY SPECIFICATION 
FOR 

AMENDMENTS TO THE DIVISION 400 OF THE 
2010 STANDARD SPECIFICATIONS 

FOR ROAD AND BRIDGE CONSTRUCTION 
 
 

This supplementary specification supplements, amends, and where in conflict therewith, 
supersedes various sections of the 2010 Edition of the Wyoming Department of 
Transportation's Standard Specifications for Road and Bridge Construction. 
 
SECTION 401 Plant Mix Pavements and Recycled Plant Mix Pavements 
 
Subsection 401.5.1 General  
 
Replace Item number 1 of paragraph 1 with the following: 
 

1. Asphalt Binder (PG __-__) by the short ton [metric ton]in accordance with Subsection 
109.1.3(8), Asphalt Materials, except : 
 
1.1  If an available aggregate source for plant mix is provided, and the aggregate 

is 100 percent crushed, or filler is allowed but not required: 

No payment will be made for the asphalt binder used daily in excess of the 
approved contractor mix design value plus 0.25 percent.   

 
When the department allows a change from an available material source in 
accordance with Subsection 106.3.2.2, Available Material Sources, no payment 
will be made for the asphalt binder percentage shown in the Material and Rates 
summary plus 0.25 percent, or the approved contractor mix design plus 0.25 
percent, whichever is less.   

 
1.2  If an available aggregate source for plant mix aggregate is provided, and 

filler is required, and the department provides a filler source: 

No payment will be made for asphalt binder used daily in excess of the asphalt 
binder percentage shown in the Material and Rates summary plus 0.25 percent.  
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3 Abbreviations, Acronyms, and Symbols 

Definitions 

Abbreviations, acronyms, and symbols are shortened forms of longer words, names, or 

expressions. Each differs from the others in formation and usage. 

 

Abbreviations in the strictest sense are shortened forms of a single word or phrase, usually 

followed by a period and often including lower case letters. Examples are Dr., etc., and chap. 

With the exception of a.m., p.m., and No. (for number), do not use abbreviations of this form. 

 

Initialisms are formed from the first letters of a string of words or an organizational name. 

The letters in an initialism are read or pronounced separately rather than together as a single 

word. Examples are PVC, IEEE, and FHWA. Do not use periods in an initialism. 

 

Acronyms are shortened forms, often initialisms, that can be pronounced as a word. Examples 

are WYDOT and OSHA. Do not use periods in an acronym. 

 

Symbols are free-standing signs, letters, or characters with unique agreed-on meanings. 

Symbols are not abbreviations and should not be punctuated or treated as such. Use a space 

before and after a symbol; symbols are not preceded by a hyphen or followed by a period. 

Examples:  lb (for pound), kg (kilogram), m
3
 (cubic meter). 

 

Rules for Acronyms and Abbreviations 

Be consistent. The shortened forms used most often in WYDOT’s Standard Specifications 

are listed in Section 101, Definitions and Terms. Additional forms are listed in this Guide. 

For the proper form of abbreviations not listed in these sources, consult chapter 10, 

―Abbreviations,‖ of The Chicago Manual of Style or chapters 9 and 10, ―Abbreviations and 

Letter Symbols‖ and ―Signs and Symbols,‖ in the United States Government Printing Office 

Style Manual, 2008. Do not invent or use forms that vary from these sources. 

 

Before introducing a shortened form not listed in Section 101, Definitions and Terms, write 

out the complete name or meaning at the first usage, followed immediately with the 

shortened form in parentheses. When introducing a word-string of common nouns and 

adjectives set in lower-case letters that will later be used in a shortened form, maintain the 

lower-case letters in the full words and type the short form in capital letters. Example:  When 

horizontal elliptical reinforced concrete pipe (HERCP) is specified . . . Install the HERCP so 

that . . . . 
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Do not introduce a shortened form that will not be reused in the same named and numbered 

section of Standard Specifications (e.g., Section 610, Curb Drains). When a previously intro-

duced short form is reused in a new named and numbered section, write out the complete 

name or meaning at the first usage in the new section, then follow with the short form in 

parentheses. 

 

The list of acronyms shown here in Table 101.4-1, Acronyms and Abbreviations Used, was 

accurate at the time the Standard Specifications was printed. Writers who plan on frequent 

use of an acronym or other shortened form not in the table should contact Field Operations, 

Construction Section to suggest its inclusion. 

 

Use the indefinite article ―an‖ before initialisms, acronyms, and abbreviations that are 

pronounced as if they begin with a vowel. If the short form begins as if it were pronounced 

with a consonant, use ―a.‖ Examples:  an AASHTO requirement, an SAE specification 

(because the letter s is pronounced es), a PSC document. 

 

Form plural acronyms by adding the lowercase letter ―s.‖ Do not use an apostrophe. 

Examples:  multiple disadvantaged business enterprise are written DBEs, not DBE’s, and 

multiple changeable message signs are CMSs, not CMS’s. 

 

Acronyms and Abbreviations Used in Standard Specifications 

(Shown as Table 101.4-1) 

 

Acronym or 

Short Form Full Name or Meaning 

  

AADT annual average daily traffic 

ac alternating current 

a.m. ante meridiem (before noon) 

AAN American Association of Nurserymen 

AAR Association of American Railroads 

AASHTO American Association of State Highway and Transportation Officials 

ACI American Concrete Institute 

ADA Americans with Disabilities Act 

AGC Associated General Contractors of America 

AIA American Institute of Architects 

AISI American Iron and Steel Institute 

AITC American Institute of Timber Construction 

ANSI American National Standards Institute 

AOSA Association of Official Seed Analysis 

AREMA American Railway Engineering and Maintenance-of-Way Association 
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Acronym or 

Short Form Full Name or Meaning 

  

ARTBA American Road and Transportation Builders Association 

ASCE American Society of Civil Engineers 

ASLA American Society of Landscape Architects 

ASME American Society of Mechanical Engineers 

ASTM American Society for Testing and Materials 

ATSSA American Traffic Safety Services Association 

AWG American Wire Gauge 

AWPA American Wood-Preservers’ Association 

AWS American Welding Society 

AWWA American Water Works Association 

BLM Bureau of Land Management 

CFR 

CMP 

Code of Federal Regulations 

corrugated metal pipe 

CMS changeable message sign 

CPM critical path method 

CRSI Concrete Reinforcing Steel Institute 

CR 

CSP 

corrosion resistance 

corrugated steel pipe 

DBE disadvantaged business enterprise 

DMS dynamic message sign 

DSR dynamic shear rheometer 

EBL eastbound lane 

EBS electronic bidding system 

EEI Edison Electric Institute 

EIA Electronic Industries Alliance 

EPA Environmental Protection Agency 

ESAL equivalent single axle load 

f Nc specified compressive strength of concrete 

FCC Federal Communications Commission 

FE flared end 

FHWA Federal Highway Administration 

FTMS Federal Test Method Standard 

HERCP 

HID 

horizontal elliptical reinforced concrete pipe 

high intensity discharge 

ICEA Insulated Cable Engineers Association 

ID inside diameter 

IEEE Institute of Electrical and Electronics Engineers 

IESNA Illuminating Engineering Society of North America 
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Acronym or 

Short Form Full Name or Meaning 

  

IMSA International Municipal Signal Association 

ISSA International Slurry Surfacing Association 

ITE Institute of Transportation Engineers 

ITS intelligent transportation system 

JMF job mix formula 

LAR Los Angeles abrasion resistance or LA abrasion 

LED light emitting diode 

LL liquid limit 

MIL Military Specification 

MS Military Standard 

MUTCD Manual on Uniform Traffic Control Devices 

NBL northbound lane 

NCHRP National Cooperative Highway Research Project 

NEC National Electrical Code as approved by ANSI and NFPA 

NEMA National Electrical Manufacturers Association 

NFPA National Fire Protection Association 

NIST National Institute of Standards and Technology 

No. number 

Nos. numbers 

NOAA National Oceanic and Atmospheric Administration 

NP 

NPDES 

nonplastic 

National Pollution Discharge Elimination System 

OD outside diameter 

OHW ordinary high water 

OSHA Occupational Safety and Health Administration 

p.m. post meridiem (after noon) 

PAMS poly-alpha-methyl styrene 

PAV pressure aging vessel 

PCI Precast/Prestressed Concrete Institute 

PE polyethylene 

PGAB performance graded asphalt binder 

PLS pure live seed 

PTC positive temperature coefficient 

PVC polyvinyl chloride 

RAP reclaimed asphalt pavement 

RC 

RCP 

RPCCP 

reinforced concrete 

reinforced concrete pipe 

reclaimed portland cement concrete pavement 

RSC rigid galvanized steel conduit 
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Acronym or 

Short Form Full Name or Meaning 

  

RTFO rolling thin film oven 

SAE Society of Automotive Engineers 

SBL southbound lane 

SE service entrance 

SI International System of Units (metric system) 

SME steel mitered end 

SSPC Society for Protective Coatings 

TAPPI Technical Association of the Pulp and Paper Industry 

TBC time-based coordination 

TCD traffic control device 

U.S. United States 

UBC Uniform Building Code 

UF wire insulation—underground feeder 

UL Underwriters Laboratories, Inc. 

USE wire insulation—underground service entrance 

UV ultraviolet 

V:H vertical units to horizontal units, ratio 

VAC voltage—alternating current 

VECP Value Engineering Contractor Proposal 

VMA voids in mineral aggregate 

VOC volatile organic compounds 

WBL westbound lane 

WCA Wyoming Contractors Association 

WCLIB West Coast Lumber Inspection Bureau 

WDA Wyoming Department of Agriculture 

WDEQ Wyoming Department of Environmental Quality 

WPSC Wyoming Public Service Commission 

WPWC Wyoming Public Works Council 

W.S. Wyoming Statute 

WSHPO Wyoming State Historic Preservation Office 

WWPA Western Wood Products Association 

WYBET Wyoming box beam end terminal 

WYDOT Wyoming Department of Transportation 

XHHW wire insulation—moisture and heat resistant; wet and dry locations; cross-linked 

polyethylene 
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Style for Use of Bid and Pay Unit Symbols in Standard Specifications 

For bid and pay units, in ―Measurement and Payment‖ subsections only, use the symbols 

shown in Table 109.1.2-1, Unit Symbols for Bid and Pay Items. Give the inch-pound symbol 

first, followed by the symbol for the SI counterpart in brackets. 

 

In ―Measurement and Payment‖ subsections, use the same names (including abbreviated 

forms) for pay items in the ―measure‖ paragraph as are list in the ―pay‖ paragraph. Example: 

 

 

415.5.1 MEASUREMENT and PAYMENT 
 

1
 The engineer will measure: 

 

1. Conc Pvmt Spall Repair by the square foot [square meter] or the cubic foot 

[cubic meter] measured in the plane of the existing concrete pavement surface. 

2. Conc Slab Replacement by the square yard [square meter], measured 

parallel to the paved surface. 

 
2
 The department will pay as follows: 

  

  

Pay Item Pay Unit 

Measure to the 

Nearest 

Pay to the 

Nearest 

Conc Slab 

Replacement 

SY [m5] 0.1 ft [0.05 m] SY [m5] 

Conc Pvmt Spall 

Repair 

SF, CF 

[m5, m;] 
0.1 ft, 0.1 ft 

[0.05 m, 0.05 m] 

SF, CF 

[0.1 m5, 0.1 m;] 
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Unit Symbols for Bid and Pay Items 

(Standard Specifications Table 109.1.2-1) 

 

Inch-Pound SI (Metric) 

Bid or Pay Unit Symbol Bid or Pay Unit Symbol 

acre ACRE hectare ha 

cubic foot CF cubic meter m
3
 

cubic yard CY cubic meter m
3
 

cubic yard hour CYHR cubic meter hour m
3
h 

cubic yard mile CYMI cubic meter kilometer m
3
km 

each EA each Ea 

force account $$ force account $$ 

gallon GAL liter L 

thousand gallons MG cubic meter m
3
 

hour HR hour h 

crew hour CRWH crew hour Crwh 

pound LB kilogram kg 

foot FT meter m 

lump sum LS lump sum LS 

mile MI kilometer km 

mile-day MIDY kilometer-day kmd 

square foot SF square meter m
2
 

shift SHFT shift Shft 

station STA station Sta 

square yard SY square meter m
2
 

short ton (2000 lb) TON metric ton t 

short ton mile TMI metric ton kilometer tkm 

 

 

Style for Measurements in Standard Specifications 

Measurements involve descriptions of quantities and are composed of a numeric value and a 

unit of measure. Use numerals for the numeric value of a measurement; use symbols to 

indicate the unit of measure. Do not use words or abbreviations for the number or units in a 

measurement. Exceptions are discussed in section 4, Numerals vs. Words, of this Guide. 
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Provide measurements (and sizes) in both inch-pound and SI (metric) units; give the inch-

pound measurement first, followed by the SI counterpart in brackets. Examples: 

 

round to a radius of c in [3 mm] 

steel with a thickness greater than ½ in [13 mm] 

excavate to a depth no less than 15 ft [4.5 m] 

add water heated to a temperature of from 70 °F to 150 °F [21 °C to 66 °C] 

 

Measurement Symbols 

(Standard Specifications Table 101.4-2) 

 

Inch-Pound Units 

(U.S. Customary System) Kind of Quantity 

or Measurement 

SI (International System) 

Units—Metric 

Symbol Unit Name Unit name Symbol 

mil mil (0.001 inch) Length micrometer m 

in inch  millimeter mm 

ft foot    

yd yard  meter m 

mi mile  kilometer km 

in
2
 square inch Area   

ft
2
 square foot    

yd
2
 square yard  square meter m

2
 

mi
2
 square mile  square kilometer km

2
 

acre acre    

fl oz fluid ounce Volume milliliter mL 

pt pint    

qt quart    

gal gallon  liter L 

in
3
 cubic inch  cubic meter m

3
 

ft
3
 cubic foot    

yd
3
 cubic yard    

oz ounce Weight [Mass] gram g 

lb pound  kilogram kg 

ton ton, short (2000 lb)  metric ton t 

°F degree Fahrenheit Temperature degree Celsius °C 
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Inch-Pound Units 

(U.S. Customary System) Kind of Quantity 

or Measurement 

SI (International System) 

Units—Metric 

Symbol Unit Name Unit name Symbol 

s second Time second s 

min minute  minute min 

h hour  hour h 

d day  day d 

mph miles per hour Speed kilometers per 
hour 

km/h 

psi pounds per square 
inch 

Pressure pascal Pa 

   kilopascal kPa 

   megapascal MPa 

W watt Power, Energy, 

and Electrical 

watt W 

kW kilowatt kilowatt kW 

A ampere  ampere A 

V volt  volt V 

VA voltampere  voltampere VA 

Ω ohm  ohm Ω 

Hz hertz  hertz Hz 

J joule  joule J 

lm lumen  lumen lm 

fc footcandle  lux lx 

   candela cd 

hp horsepower    

lbf pound-force Force newton N 

kip 1000-pounds force  kilonewton kN 

  Viscosity, Dynamic pascal second Pa•s 

KU Krebs unit  centipoise cP 

   poise P 

cSt centistokes Viscosity, 
Kinematic 

meter squared 
per second 

m
2
/s 

St stokes    

gpm gallons per minute Flow liters per second L/s 
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Standards for the use of SI (metric) symbols in the United States are provided in NIST 

Special Publication 811, 2008 Edition:  Guide for the Use of the International System of 

Units (SI), published by the National Institute of Standards and Technology, United States 

Department of Commerce, and in IEEE/ASTM SI 10 - 10 (American National Standard for 

Metric Practice). Symbols for units of U.S. customary measure appear in  paragraph 9.62, 

―Standard Letter Symbols for Units of Measure,‖ the United States Government Printing 

Office Style Manual, 2008. 

 

To use measurement symbols properly: 

 

1. Do not follow a symbol with a period unless dictated by placement at the end of a 

sentence. Measurement symbols are not abbreviations. 

 

2. Do not add an s to form a plural. The symbol remains the same whether the quantity is 

one or many. Examples:  1 kg, 2 kg (not 2 kgs); 1 ft, 2 ft; 24 h (not 24 hrs). 

 

3. Type a space between the quantity and the symbol. Examples:  1 kg, 2 ft, 25 °C. 

 

4. Precede only with numerals, never words. Example:  2 ft; not two ft. 

 

5. Do not use symbols without accompanying numerals. That is, never leave a symbol 

―naked.‖ Example:  Measurement is by the cubic yard; not the yd
3
. 

 

6. Do not mix symbols and names in the same expression. Example:  m/s or meters per  

second; not meters/second or meters/s. 

 

7. Print symbols and quantities in normal, upright (Roman) type regardless of surrounding 

text. Example:  2 ft, not 2 ft. 

 

8. Do not use unit abbreviations, short forms, or symbolic representations not shown in 

Table 101.4-2. Examples:  2 ft, not 2'; 6 in, not 6"; 5 g, not 5 gm (for grams). 

 

9. When the word ―in‖ needs to follow the symbol ―in,‖ write out the word ―inches‖ 

instead of using the symbol. Example:  greater than 0.3 inches in 25 ft [8 mm in 7.5 m], 

not 0.3 in in 25 ft. 
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Mathematical and Other Symbols Used 

(Standard Specifications Table 101.4-3) 

Symbol Meaning Word Character 

Use symbol in … 

Tables 

only 

Text and 

tables 

+ plus from keyboard   

 minus 
*02D7, Alt + x 

(not the keyboard hyphen) 
  

± plus or minus Alt + 0177   

= equal to from keyboard   

< less than from keyboard   

 less than or equal to Alt + 2264   

> greater than from keyboard   

 greater than or equal to Alt + 2265   

× 
multiplied by;  
dimensional indicator 

Alt + 0215 
(not the keyboard letter x) 

  

 arithmetic mean (or “average”) **See note statistical formulas 

/ per from keyboard   

% percent from keyboard   

 10
-6

 (“micro”) Alt + 0181   

° 
degree (angular measurement 
and temperature) 

Alt + 0176   

Ω ohm Alt + 2126   

: ratio; proportionality from keyboard   

$ U.S. dollar from keyboard   

• bullet Alt + 0149   

 

*To use the shortcut key for the minus sign in Word, type in the number shown in this table where the 

symbol is to appear and then hold down the Alt key while typing x. The symbol will replace the 

numbers typed.  

 

**Word 2007 does not, at the time of publication, have a symbol for arithmetic mean. However, if the 

specification writer uses a computer that has WordPerfect installed on it, the symbol can be found in 

Word under the Insert tab, Symbol icon. Click on More Symbols to open the Symbol dialog box. Click 
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on the Font drop down arrow and choose the WP MathB font. Scroll through the font options to locate 

the  symbol, click on it, and click the Insert button to add it to the document at the cursor location. 

Close the dialog box by clicking on Cancel. 

 

To add the other Word characters from Table 101.4-3 to a document, hold down the Alt key 

while typing in the number shown. The character will be inserted at the cursor location once 

the Alt key is released. 

 

When using mathematical and other signs and symbols: 

 

1. Type a space before and after. Example:  2 in × 2 in × 1 in [50 mm × 50 mm × 25 mm]. 

Exceptions:  no space follows  (a 75 m sieve); no space precedes the angular degree 

symbol (180º); no space follows the minus sign when used in a temperature that is below 

zero degrees (5 °F [20 °C]); and no space follows the numeral when the percent 

symbol is used in a table (0.4%). 

 

2. In text, use words for those quantitative relationships indicated in the preceding table. 

Example:  Fasten reinforcing bars securely except where the spacing is less than 1 ft 

[300 mm]. 

 

Ranges 

Do not use a dash ( - ) to indicate a range. 

 

Use the words ―from‖ and ―to‖ in text to indicate a range of values in which the endpoints are 

included (in tables use only ―to‖). Provide the unit symbol after each numeric value. 

Examples:  from 1 in to 3 in [25 mm to 75 mm]; from 77 °F to 86 °F [25 °C to 30 °C]. 

Exceptions:  When a range is described with the word ―percent,‖ or when an unambiguous 

span of time is described using ―second,‖ ―minute,‖ or ―day,‖ use the word only once, at the 

end of the range. Examples:  15 to 25 percent; from 24 to 48 hours. 

 

To indicate a range from which the endpoints are excluded, use the words ―between‖ and 

―and.‖ 

 

When indicating a range in an electrical reference, use ―to.‖ Example:  0 V to 5 V. 
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Additional Rules and Examples 

Write: 

 

… so that it is completely clear to which unit symbols the numerical values 

of the quantities belong. 

    — National Institute of Standards and Technology 

    NIST Special Publication 811 

 

Measurement symbols always require a preceding numerical value and are never preceded or 

followed by a hyphen. The spelled-out unit name may be preceded by a number expressed as 

a word and must be preceded by a hyphen when the number and name are used together as an 

adjective, but no hyphen is used in the metric equivalent. Examples:  a 1-inch [25 mm] pipe; 

a ½-inch [13 mm] diameter mandrel. 

 

Use the multiplication cross symbol (×) to indicate dimensionality, not the word ―by.‖ 

Provide the unit symbol after each numeric value. Example:  2 in × 4 in; not 2 in by 4 in. 

 

Additional examples: 

 

6 ft × 6 ft [2 m × 2 m] 

6 ft × 6 ft × 6 in [2 m × 2 m × 150 mm] 

9:00 a.m.; 2:00 p.m. 

1 in ± 
1
/32 in [25 mm ± 1 mm] 

a slope greater than 1:20 

10 °F [23 °C] 

 

tolerance should be minus 0 degrees; plus 45 degrees 

heated to 200 °F [90 °C] for a length of 1 in [25 mm] 

nitrogen per 100 yd
2
 [80 m

2
] 

make posts from No. 1 structural steel 

90 percent finer than a No. 4 [4.75 mm] sieve 

after storage for 30 days at 75 °F ± 5 °F [24 °C ± 3 °C] 
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4 Numerals vs. Words 

General 

Use numerals for measurements, sizes, and critical or precise quantities. Examples:  Maintain 

a surface temperature of 70 °F [20 °C] for 72 hours; gouges not more than ¼ in [6 mm] deep; 

mark the weight [mass] on members heavier than 3 ton [2.7 t]. 

 

Use numerals when cross-referencing sections, subsections, and other parts of Standard 

Specifications or similar sources. Example:  … materials required by AASHTO section 5. 

 

Use numerals for numerical values greater than ten; i.e., use numerals for the number 11 and 

higher. 

 

Use words for numbers at the beginning of a sentence; if a number greater than ten appears at 

the beginning of a sentence, reorder the sentence if possible. Example:  Thirty minutes before 

installation, begin preparing the material. Or:  Begin preparing the material 30 minutes 

before installation. 

 

Use words for quantities or values of ten and below that are not critical, precise, or of 

paramount importance in the context. Examples:  Fabricate from not more than two pieces of 

sheet steel. Furnish six sets of drawings. 

 

When quantity and size are expressed together, use numerals for the size and words for the 

quantity. Examples:  three ½-inch [13 mm] holes; twenty-two 50-pound [25 kg] weights. 

 

Be consistent. Within the same context, treat similarly all numbers that refer to the same 

category of things. Examples:  Ensure a moisture content of 7 to 12 percent. Thirty minutes 

before starting, and again sixty minutes later, … 

 

Decimals 

Express decimals in numerals, not words. Example:  0.1, not one-tenth. 

 

Never leave a decimal point ―naked‖—that is, without numerals on both sides. Examples:  

1.5, 6.125, 0.5, 0.125. 

 

Use decimals in all SI (metric) expressions with numeric values other than a whole number. 

Examples:  1.5 m; 0.5 kg. 
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Time and Date 

Use numerals for clock times. Keep zeros when describing times ―on the hour.‖ Use the 

standard 12-hour system, with all numerals accompanied by the appropriate a.m. or p.m. 

designation (using lower-case letters, followed by periods); leave a space between the 

numeral and abbreviation but no spaces inside the abbreviation. Examples:  9:00 a.m., 10:30 

p.m. 

 

Exception:  Use the words ―noon‖ and ―midnight‖ to indicate twelve o’clock. Do not use the 

numeral 12 followed by a word or abbreviation. Example:  Do not work from noon to 

midnight. (Not 12 noon or 12 p.m.; not 12 midnight or 12 a.m.) 

 

Use words (written in full) for the names of months and numerals for days of the month and 

years.  Do not use ordinal designators (e.g., 
th

 and 
rd

) in dates. Examples:  June 15, 2001; 

from May 1 to September 30. 

 

Money 

Use numerals for monetary amounts. Do not include the decimal and zeros for the cents 

when amounts are in whole dollars. Do not leave a space between the dollar sign ($) and 

numeric value. Example:  Bill at the rate of $1,500 per mix. 

 

Fractions 

Determine whether it is technically correct to use fractions or decimals. In most cases, use 

numeric fractions when expressing inch-pound measures and sizes. Examples:  Leave the cut 

end at least c in [3 mm] above the base; drill to a depth of ¼ in [6 mm]. However:  

Construct from aluminum alloy sheet at least 0.0051 in [300 m] thick. 

 

Use numerals for mixed fractions; do not leave a space between the whole number and 

simple fraction. Examples:  Join the top to the bottom with an arc of not more than 87½ 

degrees; leave a distance of no more than 1¾ times the diameter of the bolt. 

 

Use numeric fractions when forming a unit-modifier or compound adjective; follow the 

fraction with a hyphen, and use the full unit name. Examples:  a 1½-inch [40 mm] pipe; a ¼-

mile [0.4 km] open space. 

 

Use Microsoft Word’s built-in typographic symbols to enter common numeric fractions. To 

do this with a mouse, under the Insert tab, click the Symbol button in the Symbols group. If 

the fraction you need is shown, double-click on it to insert it into your text at the insertion 

point. If the fraction you need is not there, click on More Symbols. In the Font drop down 
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menu, choose either ―(normal text)‖ or another font—usually Times New Roman or Arial, 

and in the Subset drop down menu choose Number Forms. Scroll through the characters to 

find the fraction needed, and either double-click on it or select it and click the Insert button. 

The fraction will appear at the insertion point in the text once the Alt key is released. 

 

Shortcuts for some common fractions are shown in the following table. To use them, and 

depending on the shortcut key shown, either hold down the Alt key and type in the number 

shown or type in the number or number-letter combination shown, hold down the Alt key, 

and press the x key. The fraction will then appear at the cursor’s location. 

 

Typographic Fraction Characters in Word 2007 

 

Fraction Word Shortcut Key 

½ Alt + 0189 

¼ Alt + 0188 

¾ Alt + 0190 

⅓ 2153, Alt + x 

⅔ 2154, Alt + x 

⅛ 215b, Alt + x 

⅜ 215c, Alt + x 

⅝ 215d, Alt + x 

⅞ 215e, Alt + x 

 

 

Fractions other than those that come with Word can be created by making the numerator 

superscript and the denominator subscript. The following is one way to create fractions: 

 

1. Type in the fraction with regular numbers separated by a slash. Examples:  3/32, 7/16, 

13/5. 

2. To create the numerator, select it with the mouse, and either click on the superscript 

button under the Home tab and in the Font group [x2
] or use the shortcut for creating 

a superscript by holding down the Alt and Shift keys and pressing the + key. 

Examples:  
3
/32, 

7
/16, 1

3
/5. Note that there is no space between the whole number and 

the numerator of the fraction. 

3. To create the denominator, select it with the mouse, and either click on the subscript 

button [x2], which is next to the superscript button, or use the shortcut for creating a 

subscript by holding down the Ctrl key and pressing the = key. Examples:  
3
/32, 

7
/16, 

1
3
/5. 
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Use words for simple fractions that do not describe a measurement or a precise quantity, that 

stand alone, or that come before the words ―of a‖ or ―of an.‖ Use a hyphen to connect the 

numerator and denominator. Examples:  Add mulch when the tank is at least one-third full of 

water. Use a spray bar three-fourths the length of the mixer or greater. Payment will be one-

half the unit price. Use straw, hay, or sawdust to fill the lower one-fourth to one-third of the 

trench. 

 

Percent 

Use the word ―percent‖ in text and precede with a numeral. Examples:  If the average density 

is less than 95 percent, but no one sample is less than 92 percent, divide the samples into two, 

five-sample lots. Changes greater than 5 percent will …. A minimum of 4 percent moisture 

…. Provided the quantity does not exceed 0.1 percent of the total contract cost, or $2,500, 

whichever is greater (not one-tenth of one percent). 

 

Hyphens and Unit Modifiers 

When a number and word (usually a unit name) work together to describe something else 

(usually an object or material, like a pipe, bolt, or board), they are acting as a single word, or 

adjective, called a unit modifier. 

 

Use a hyphen between the number and word in unit modifiers; do not use hyphens with unit 

symbols. Examples:  Cut two, 4½-foot [1.5 m] long test samples of any size 400-grade bar. 

Install a 400-watt, 120-volt, bar-type electric heating unit in all controller cabinets. Construct 

the cabinet from 0.125-inch [3 mm] thick aluminum. 

 

When the context requires both inch-pound and SI (metric) measures, use the full name of 

the inch-pound unit, placing a hyphen between the numerical value and the unit name, then 

write the SI counterpart in parentheses immediately afterward (using numerals and SI 

symbols only) before any additional adjectives are used. Examples: 

 

a ½-inch [13 mm] pipe a ¾-inch [19 mm] diameter shank 

three 2½-inch [63 mm] pipes an 8-pin, jones-type socket 

a ten-day notice a 2-inch [50 mm] hose 

  

a 6-inch [150 mm] layer, but a 1-pound [454 g] sample, but 

a layer 6 in [150 mm] deep a sample of 1 lb [454 g] 
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Commas vs. Spaces 

In dollar figures, use commas in expressions of four digits or more (i.e., amounts greater than 

$999). Examples: $800; $1,000; $10,000; $2,000,000. 

 

In inch-pound expressions, use commas in numeric values with five or more digits. 

Examples: 1000 ft; 2500 psi; 10,000 psi; 1,000,000 gal. 

 

In SI (metric) expressions, use spaces in numeric values with five or more digits. Examples: 

900 MPa; 1000 MPa; 1300 m; 10 000 km. 
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5 Punctuation 

Serial Commas 

In a series of three or more elements, separate the elements with a comma. Use a comma before the 

conjunction (―and‖ or ―or‖) joining the last two elements. Examples: 

 

Provide a minimum of eight individually selectable outputs, each selectable by time-of-day, day-

of-week, and week-of-year. 

 

Do not use mortar blocks, bricks, wood, or aluminum framework in supporting deck slab 

reinforcement. 

 

Protect trees, shrubs, and other landscape features designated by the engineer for preservation 

from abuse, marring, or damage during construction. 

 

With Closing Quotation Marks 

Place periods and commas required by a sentence inside closing quotation marks, regardless of 

whether the period or comma is part of the quoted matter. Examples: 

 

Lay the downstream end of each blanket on top, creating a ―shingle effect.‖ 

 

The contact pressure is ―the average ground contact pressure,‖ expressed in pounds per square 

inch (pascals). 

 

Quotation Marks When Referencing Signs and Labels 

When referring to specific words that appear elsewhere on signs, labels, drawings, and the 

like, use quotation marks. Do not use all-capitals, bold typefaces, or similar typographic 

features for added emphasis. Examples: 

 

Mark each drawing ―final.‖ 

 

Submittals will be marked ―approved,‖ ―approved as corrected,‖ or ―not approved.‖ 

 

Mark the pull box covers ―WYDOT Traffic Signal‖ when the box contains traffic signal 

conductors. 
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Letters as Shapes 

Type letters used as shapes in a sans serif font, such as Arial. Do not use quotes around the letter. 

Link the letter and following word with a hyphen if warranted. Examples:  

 

 U-shaped staples Y-connector 

 an A-frame structure U-bolts 

 I-connector an S curve 

 O-ring   H-pile 

 a J-seam 

 

To make letters used as shapes plural, add and ―s‖ and no apostrophe. Example: Vs, not V’s. 

 

Parentheses 

Use parentheses to insert and set off additional information relevant to the sentence. Do not use 

dashes for this purpose in Standard Specifications (because of the possibility of confusion with 

the minus sign or similar marks or symbols). Example:  Nut rotation is relative to the bolt 

regardless of the element (nut or bolt) that is turned. 

 

Parentheses are also used to insert and set off counterparts or equivalencies, such as chemical 

formulas. Example:  Conform to the requirement for chrome oxide (Cr2O3) green. 

 

Place commas, semicolons, periods, or other punctuation that the main sentence might need after 

the closing parenthesis mark. 
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6 Capitalization 

General 

Aim for consistency, especially within specifications. For situations not addressed in this Guide, 

consult chapter 8, ―Names and Terms,‖ of The Chicago Manual of Style or chapter 3, 

―Capitalization Rules,‖ in the United States Government Printing Office Style Manual, 2008. 

 

Avoid over-capitalization. Excessive capitalization slows reading and reduces the very emphasis 

capitalization is meant to achieve. 

 

Specific 

Capitalize the following words or categories of specific names and things: 

 

ACRONYMS and INITIALISMS 

 

Bid and pay item names in the ―Measurement and Payment‖ subsections;  Examples: 

 

 Liquid Asphalt 

 Structural Steel 

 Sign Posts, Wood 

 

Document titles; Examples: 

 

 the Engineer’s Weekly Report 

 Certificate of Compliance 

 

Laws and legislative acts; Examples: 

 

 the Wyoming Seed Law 

 the Federal Seed Act 

 Clean Air Act 

 Wyoming Statute 11-14-101 

 

Official titles; Example: 

 

 the State Bridge Engineer 

Program (when referring to specific programs within WYDOT); Examples: 
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 Field Operations Program 

 Highway Development Program 

 Materials Program 

 Traffic Program 

   

Proper nouns 

 

Titles of sections, subsections, tables, and figures in Standard Specifications; Examples: 

 

 Measure pipe in accordance with Section 603, Culverts and Storm Drains. 

 Apply at the rate specified in Subsection 513.4.13, Curing Concrete. 

 Remove forms and supports in accordance with Table 513.4.14-1, Minimum 

 Times for Forms and Support Removal. 

 

Do not capitalize: 

 

bidder 

class (when referring to a designated class of material; e.g., class A concrete) 

commission (when referring to the Wyoming Transportation Commission) 

contractor 

department (when referring to WYDOT) 

district (when referring to the districts of WYDOT) 

district engineer 

engineer 

fabricator 

federal 

federal-aid 

grade (when referring to a designated grade of material; e.g., grade No. 1 timbers) 

inspector 

plans 

portland cement 

professional engineer 

special provisions 

specification 

subcontractor 

type (when referring to a designated type of material; e.g., mulch tack, type M) 

work (even when referring to the defined term) 
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7 Lists 

General 

Lists may be used at any subsection level, when logically appropriate. Number each item in a 

list, starting with the numeral 1, followed by a period. 

 

For each numbered item within a list, one secondary level of sublists may be used. Number each 

item within a sublist, indicating first the number of the parent item in the primary list, followed 

by a period, and then starting with the numeral 1, followed by a period. Example: 

 

SECTION 507 
Reinforced Bridge Approach Fills . . . 

 

 507.1 DESCRIPTION 

 507.2 MATERIALS 

 507.3 EQUIPMENT 

 507.4 CONSTRUCTION 

 507.4.1 Reinforced Bridge Approach Fills 

1 
Submit a sample of the embankment-and-retaining-wall-reinforcement geotextile to the 

engineer at least two weeks before intended use . . .  

 
2
 Place perforated and nonperforated pipe along the base of the abutment backwall and 

sloped to drain. If necessary to ensure proper drainage, extend the pipe through the 

abutment wing-wall . . . 

 
1. First item in a hypothetical primary list, if needed. 

2. Second item in primary list, if needed. 

 2.1. First item in secondary list, if needed. 

 2.2. Second item in secondary list, if needed. 

3. Third item in primary list, if needed. 

 

 507.4.2 Concrete Approach Slabs 

 507.4.3 Foundations 

 507.5 MEASUREMENT and PAYMENT 
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Punctuation 

1. When the items in an enumerated list are made up of single items or groups of items, end 

each list item with a semicolon. Many times these lists are preceded by a colon. Include 

either an ―and‖ or an ―or‖ following the last semicolon in the list. Example: 

 

 

 

2. When the items in an enumerated list are incomplete sentences, use a semicolon at the end of 

the list item. These may also be preceded by a colon and should include either ―and‖ or ―or‖ 

after the last semicolon. Example: 

 

 

2
 At a minimum, address the following topics: 

 

1. Testing personnel and their qualifications; 

2. Equipment; 

3. Time frames of correlation testing; 

4. Test intervals; 

5. Variables or options allowed by testing procedures (i.e., shaking time for sieve 

analysis, core drying, and soaking times, etc.); and 

6. Where and how referee samples will be stored. 

 

 
1
 Install backer rod only when 

 

1. AASHTO M 301 WY Modified sealant is specified; 

2. Final width of crack or reservoir exceeds ⅜ in [10 mm]; and 

3. Full depth of crack, including routed reservoir if applicable, exceeds 1½ in [38 

mm]. 
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3. If there are only two items in an enumerated list that would usually require a semicolon after 

the item, end the first item with only an ―and‖ or an ―or‖ with no punctuation before it. 

Example: 

 

 

4. Use a period at the end of an enumerated list in which the list items are complete sentences. 

Example: 

  

 
3
 Provide luminaire mounting configurations that 

 

1. Are predrilled for mast arm attachments and supplied with mast arms or 

2. Have hot-dip galvanized tenons epoxy-bonded to the fiberglass shaft. 

 

 
1
 Mix mulch tack type MC in the following sequence: 

 

1. Fill application equipment with one-third of the water required and start 

mechanical agitation. 

2. Slowly pour the mucilage-gum powder into the tank agitating source. Add the 

remaining water. 

3. Add wood fiber, seed, and fertilizer as specified. Continue agitation for 

approximately five minutes before application. 
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5. Use a period at the end of enumerated list items when the list includes long items that contain 

a complete sentence. When this applies to one item in the list, end all items in the list with a 

period. Example: 

 

 
6. End the items in an enumerated list with a period when the listed items contain a bolded 

introductory element, usually followed by a period. Example: 

 

7. Use a period at the end of each enumerated item in all ―Measurement and Payment‖ sections. 

 

8. Do not create a list that consists of only one item. Instead, incorporate that item into the 

referencing sentence. Example: 

 

 
 
  

 
10

 When specified, or approved by the State Bridge Engineer, use oversize, short-slotted, 

and long-slotted holes in accordance with the following: 

 

1. With ⅝-inch [16 mm] diameter and larger high-strength bolts. 

2. Oversize holes in any or all plies of friction-type connections. 

3. Short-slotted holes in any or all plies of friction- or bearing-type connections. 

Align slots normal to the direction of loading in bearing-type connections. 

4. Long-slotted holes in one of the connecting parts of a friction- or bearing-type 

connection at an individual faying surface. 

 
4
 Seal cracks so that the finished, cured surface is to the configuration specified: 

 
1. Flush Configuration. Flush with the pavement and is not recessed into the crack 

by shrinkage. 

2. Recessed Configuration. Recess below the pavement ¼ in [6 mm]. Do not use 

squeegees or wands with a 2-inch [50 mm] inside diameter cup. 

 
 

 

4
 Provide carpet material that will create an acceptable texture and is in accordance with the 

following: 

 

1. The carpet does not roll or tear the surface. 

 

Replace with: 
 

4
 Provide carpet material that will create an acceptable texture and does not roll or tear the 

surface. 
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Structure 

Use parallel structure when creating lists by beginning each item in a list with the same part of 

speech—noun, verb, adjective, etc. Example—each enumerated item begins with a verb: 

 

 

 

Example—each enumerated item begins with a preposition: 

 
3
 The use of alternative methods or equipment resulting in work that fails to meet contract 

requirements may lead the engineer to, in writing: 

 

1. Direct a stop to their use; 

2. Order the completion of remaining work using the original specified methods or 

equipment; or 

3. Require the removal of the unsatisfactory work. 

 
5
 During suspensions, at no additional cost to the department, store materials and 

equipment: 

 

1. Outside the clear zone; 

2. As far from the travel way as possible; and 

3. At a location that will not cause maintenance or safety problems for the roadway. 
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8 Tables, Figures, and Forms 

General 

Keep tables and figures as simple as possible, both in layout and content. Display information so 

that it can be grasped quickly and without confusion. For additional guidance on the format and 

design of tables, consult chapter 3, ―Illustrations and Tables,‖ of The Chicago Manual of Style 

and chapter 13, ―Tabular Work,‖ in the United States Government Printing Office Style Manual, 

2008. 

 

Tables 

Number all tables, with the number itself preceded by the word ―Table.‖ Use the subsection 

number, followed by a hyphen and the number of the table within the subsection, starting with 

numeral 1. Begin renumbering with each new subsection. Number tables only out to the third set 

of digits. Example: Table 000.0.0-0, not Table 000.0.0.0-0. 

 

Give every table a title; capitalize the first letter only of all significant words. Do not place a 

period at the end. 

 

Center table, number, and title horizontally on the page. Place the table number and title each on 

its own line, and set both in bold-faced, 12-point Arial type. Set the table number above the title, 

and place both above the table. 

 

Use 11-point Times New Roman type for table text, and make column headers bold. 
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Use internal vertical grid lines on tables with more than two columns, and use horizontal grid 

lines for all tables. Use a single, 1-point line for the very top and bottom grid lines, as well as the 

grind line under the column headers. Make internal horizontal lines of a ¼-point thickness. 

Leave the left and right sides of the entire table without grid lines. Examples: 

 

Table 210.5.1-1 

Backhoe Pay Factor 

Backhoe Type Pay Factor 

I 1.0 

II 1.15 

III 1.0 

IV 1.15 

 

 

Table 607.4.2-1 

Length of Wire Gates 

Location 
Length 

ft [m] 

Gate Sticks 

(equally spaced) 

Approaches 16.5 [5.0] 4 

Gates used by large farm and 

 ranch machinery 

20 or 24 

[6.0 or 7.2] 

(as specified) 

5 

Separation structures and wing 

 fences 
12.0 [3.6] 3 

Pedestrian access 4.5 [1.4] 2 

 

In text, refer to tables by number and title. Example:  See Table 607.4.2-1, Length of Wire Gates. 
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Figures 

Number all figures, with the number itself preceded by the word ―Figure.‖ Use the subsection 

number, followed by a hyphen and the number of the figure within the subsection, starting with 

numeral 1. Begin renumbering with each new subsection. 

 

Give every figure a title; capitalize the first letter only of all significant words. Do not place a 

period at the end. 

 

In text, refer to figures by number and title. Example:  See Figure 513.4.2-2, Evaporation 

Nomograph. 

 

Center figure, number, and title horizontally on the page. Place the figure number and title each 

on its own line, and set both in bolded, 12-point Arial type. Set the figure number above the title, 

and place both below the figure. 

 

Example: 

 

   

R
ea

l 
C

o
ld

 

 C
o
ld

 

 

 

 

 

  

J
u

st
 R

ig
h

t 

 

 

 

 

  

H
o
t 

 

 

 

 

  

R
ea

l 
H

o
t 

 

 

 

 

  

D
o
n

’t
 G

o
 T

h
er

e 
   

  

        

 
            

Real Fast             

Fast             

In-between             

Slow             

Real Slow    

 

        

 

Figure 513.4.2-2 

Evaporation Nomograph (Adapted) 
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Forms 

When referencing specific forms, give both the full form title and number. Place quotation marks 

around the title of the form, and follow it with the word ―Form‖ and the appropriate number in 

parentheses. Example:  The engineer and the contractor may negotiate new unit or lump sum 

prices by using a ―Contract Amendment‖ (Form E-61) before the work is performed. 

 

The word ―Form‖ and the number may be used alone only upon second reference within the 

same paragraph as the initial full form title and form number. 
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9 Wording of Specifications 

General 

Use the simplest language that says clearly and accurately what needs to be said. Write as if you 

were speaking or giving directions aloud. Avoid jargon, contorted wording, and pseudo-

legalisms. Use terms with legal meanings only on advice from counsel. 

 

Active Voice 

Voice is a property of verbs that indicates whether the subject of the sentence acts or is acted 

upon–either active or passive. In the active voice, the subject is the doer of the act, and the verb 

makes clear within the sentence who is doing what. That is, the active voice leaves no doubt who 

is responsible for the action described. When feasible, keep sentences as simple as possible by 

using one-word verbs. Example: 

 

The department specifies the dimensions. 

 

The department did the deed, and the verb specifies says in one word what the department did. 

However, occasionally the verb in the active voice requires a helping verb to complete the action 

or intention. Example: 

 

The engineer may test for consistency of individual loads. 

 

In this case, using the one-word verb tests would not completely convey the intended meaning of 

the sentence. May here indicates that it is at the engineer’s discretion if he or she will test the 

loads. Remember, this sentence is still in the active voice because the doer of the action is 

conducting the action and appears in the sentence . 

 

In contrast, sentences in the passive voice needn’t say anything about the doer of the action. 

Responsibility does not have be to assigned. In addition, verbs in the passive voice always need 

help, and even at their simplest, they always must be accompanied by a form of the verb to be 

(which includes is, was, will be, shall be, etc.). Example: 

 

The concrete was ordered. 

 

The contractor may have done it, but we don’t know; the sentence doesn’t say. Furthermore, the 

passive ordered must be helped by was. These are the traits of a sentence in the passive voice: 

the verb is packaged in a phrase with a form of to be, and the doer of the action does not have to 
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be identified. (If the doer is identified, the identification comes after the verb in a phrase that 

begins with by. For example: The concrete was ordered by the contractor.) 

 

The active and passive voice each have their uses. The active voice is best used when it is 

important to identify the party responsible for the action in a sentence. Example: 

 

Weigh masters will determine tonnage. 

 

The passive voice is appropriate when the action is more important than the doer. Example: 

 

Tonnage will be determined. 

 

As a general rule for writing in Standard Specifications, and except as noted elsewhere in this 

Guide, use the active voice rather than the passive. 

 

Imperative Mood 

Mood is a property of verbs that conveys the writer or speaker’s belief about the truth or nature 

of the sentence—whether it is meant to be a command, a fact, or conjecture. There are three verb 

moods in English:  imperative, indicative, and subjunctive. 

 

The imperative mood is used to give a command or instruction. A distinctive feature of state-

ments in the imperative mood is that they leave out the subject of the sentence—that is, the 

subject is understood but never stated. Example: 

 

Order the concrete. 

 

This sentence is written in both the active voice and the imperative mood. Because the Standard 

Specifications (Subsection 101.1, Active Voice and Imperative Mood) already makes clear who 

the direction is addressed to, the party responsible for carrying out the directive—the 

contractor—does not need to be stated. The complete sentence is understood to be: 

 

[Contractor,] order the concrete. 

 

The second type of verb mood is the indicative mood, which is used to indicate statements of fact 

and description. The indicative mood is used frequently in the Standard Specifications. In the 

following example, the statement is intended as a simple description of what is, or is meant to be, 

and the verb will establish is in the indicative. (Because most verbs have voice and mood at the 

same time, the sentence is in both the indicative mood and the active voice.) Example: 
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The engineer will establish right-of-way and constructions lines. 

 

The final mood type is the subjunctive mood. Because it is used to convey doubt or conjecture or 

to pose a ―what if‖ situation, the subjunctive mood is rarely used in the Standard Specifications. 

Example: 

 

If slotted or oversize holes were specified, the contractor would use hardened flat washers. 

 

Voice and Mood in Standard Specifications 

When giving instructions to the contractor, use the active voice and imperative mood. Examples: 

 

 
  

To provide information, use the indicative mood. In most situations, use the combination of 

active voice and indicative mood. Examples: 

 

 
 

When the emphasis is on a condition or situation, the passive voice and indicative mood may be 

most appropriate. Example:  Approximate areas are shown in the contract. 

 

Description Subsection 

The purpose of this subsection is to describe the work identified in the section title and addressed 

by the remainder of the section. Use the active voice and indicative mood. Example: 

 

 
 

Do not use phrases such as ―… in accordance with these specifications and as shown on the 

plans.‖ This point is covered in Division 100, General Provisions, and need not be repeated. 

  000.1 DESCRIPTION 

 
1
 This section describes the requirements for constructing or modifying bridge, pedestrian, 

or approach railings. 

 

 

 The state retains ownership of salvaged materials. 

 The department will not accept computer printouts for design calculations. 

 

 

  Furnish and install high strength fasteners for structural connections. 

 Meet the requirements of Section 413, Hydrated Lime. 

 Give two copies of the completed form to the engineer. 

 When using mineral filler, provide an additional bin. 

 



Wording of Specifications  Page 39 of 49 

 

Specifications Writers’ Style Guide August 2011 

Material Subsection 

This subsection provides the requirements for the materials that must be used to accomplish the 

work addressed in the section. Use the active voice and imperative mood. Arrange material items 

alphabetically. Example: 

 

 
 

Equipment Subsection 

This subsection provides equipment requirements needed to accomplish the work addressed in 

the section. Use the active voice and imperative mood. Example: 

 

 
 

Construction Subsection 

This subsection provides information on how to accomplish the work addressed in the section. 

Use the active voice and imperative mood. Example: 

 

 
 

000.4 CONSTRUCTION 
 
1
 Apply paint on clean, dry surfaces. Do not apply when the temperature of the steel or 

paint, or the air temperature is below 40 °F [4 °C]. Do not apply to wet, damp, frosted, 

or ice-coated surfaces. 

 

  

 

 

000.3 EQUIPMENT 
 
1
 Support pile hammers in leads when driving piles. Construct leads to permit free 

movement of the hammer and rig to hold the pile and hammer in alignment during 

driving. Use steam, air, or diesel hammers capable of delivering enough energy to drive 

the piles to the required bearing capacity. Do not use gravity pile hammers. 

 

  

 

 

000.2 MATERIALS 
 
1
 Provide materials in accordance with the following: 

 

 Materials  Subsection 
 Aggregates  000.0 

 Emulsified Asphalt 000.0 

 
2
 Stockpile aggregates in accordance with Section 000, Stockpile Maintenance. 
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Measurement and Payment Subsection 

This subsection provides information on how WYDOT measures items for payment and pays for 

measured items. 

 

For the measurement portion of the subsection, use the active voice and indicative mood to 

introduce the engineer as the party responsible for measurements; extended discussion of 

measurement may then be continued in the passive voice. Number each group of items that are 

measured using the same unit of measurement. Use full, spelled-out names for measurement 

units. Capitalize the names of bid and pay items. 

 

For the payment portion of the subsection, use the active voice and indicative mood. List pay 

items alphabetically. Use the symbols shown in Table 109.1.2-1, Unit Symbols for Bid and Pay 

Items, giving the inch-pound symbol first, followed by the SI counterpart in brackets. Example: 

 

 
 

 

Do not list what work is included in the payment for the item in this subsection because the work 

is already described in the construction subsection of the section. 

 

If the work is described in the construction subsection, but it is not intended to be paid for under 

the listed pay item, use Subsection 000.5.2, referenced sections for direct payment to indicate 

where in the Standard Specifications this particular work is to be paid. 

 

219.5 MEASUREMENT and PAYMENT 
 
1
 The engineer will measure: 

 

1. Driven Anchors and Grouted Anchors by the each. 

 

 2. Rockfall Mesh by the square yard [square meter] complete in place. 

 
2 

The department will pay as follows: 

Pay Item Pay Unit 
Measure to the 

Nearest 

Pay to the 

Nearest 

Driven Anchors EA [Ea] EA [Ea] EA [Ea] 

Grouted Anchors EA [Ea] EA [Ea] EA [Ea] 

Rockfall Mesh SY [m
2
] 0.1 ft [0.05 m] SY [m

2
] 
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10 Other Wording and Usage 

General 

Choose the wording that says most clearly and efficiently what needs to be said. Say no more 

than that, but say exactly that. 

 

Needless Words and Jargon 

Many words serve only as filler. Their use adds clutter and can hinder a reader’s ability to grasp 

what’s important. Omit words that do not add meaning. Favor a single word over a phrase. 

Avoid jargon. 

 

Alternatives to Common Wordy Phrases 

Instead of . . . Use or Consider . . . 

a minimum of at least 

absolutely essential essential 

ambient, atmospheric air 

as may be necessary as necessary 

at a later date  later 

commence begin (or start) 

cost thereof cost of 

dispose of at a contractor-furnished site becomes the contractor’s property 

enclosed herewith enclosed 

fails to does not 

give due and sufficient written notice give written notice 

impracticable impractical 

in order to to 

in lieu of instead of 

in the event of if 

in advance of before 

job site project 

practicable practical 

prior to before 

through the use of by 

until such time as until 

utilize use 

worksite project 
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Words and Phrases Not to Use 

Many of the words or phrases in the following list add no meaning, add confusion, or introduce 

passages that are unnecessary because the same information is covered elsewhere in Standard 

Specifications, usually in Division 100, General Provisions. 

 

Do Not Use 

―as shown on the plans‖ or similar wording 

―as approved by the engineer‖ or similar wording 

―at the contractor’s expense‖ 

―care shall be taken‖ 

―conformance‖ 

―contract item‖ 

―in the plans‖ 

―in the specifications‖ 

―neither … nor‖ 

―permit‖ when used to mean ―allow‖ 

―pertinent‖ 

―special attention of the contractor‖ 

―subsidiary‖ 

―the attention of the contractor is directed to …‖ 

 

Usage of Specific Words or Phrases 

And/Or.  This construction is awkward and confusing. Write ―red, blue, or both‖ not ―red and/or 

blue.‖ Example, ―Fabrication includes . . . other inserts, sleeves, or both‖; not ―Fabrication 

includes . . . other inserts and/or sleeves.‖ 

 

Appropriate.  Use instead of ―pertinent‖ for stating or attaching relevant information. Example: 

―Include material thicknesses and other appropriate data needed for fabrication.‖ 

 

As shown on the plans.  This phrase is generally unnecessary because the contractor’s obliga-

tion regarding plans is specified in Subsection 105.3, Conformity with Contract. 

 

As specified in.  Use instead of ―as described in,‖ ―as designated in,‖ ―as indicated in,‖ 

―pursuant to,‖ or similar phrases that reference provisions of a specification. 
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At no additional cost to the department.  Use instead of ―at the contractor’s expense.‖ 

 

Bid item.  As defined in Section 101, Definitions and Terms, for use before a contract is signed; 

use instead of ―contract item,‖ ―contract bid item,‖ or similar phrases. After a contract is 

signed, use ―pay item.‖ 

 

Conform, Conforming, and Conformance. Use ―accordance‖ or ―in accordance with‖ instead 

of ―conformance.‖ Example:  ―Provide magnesium sulfate in accordance with AASHTO T 

104.‖ The word ―to‖ always follows ―conform‖; ―conforming‖ is followed by ―to‖ or ―with.‖ 

 

Ensure vs. Insure vs. Assure.  These are three different verbs with three different meanings. In 

Standard Specifications, the correct word will almost always be ―ensure,‖ which means ―to 

make sure of‖ (Example:  Extend the pipe to ensure proper drainage). Use ―insure‖ only 

when speaking of the sort of financial protection offered by insurance companies. ―Assure‖ is 

only used when giving reassurance to another person, as in ―Let me assure you that . . .‖ 

 

In the contract.  Use instead of ―in the specifications‖ or ―on the plans.‖ 

 

Incidental.  Use instead of ―subsidiary.‖ Example:  ―When the contract does not contain pay 

items for the removal of structures and obstructions, including culverts and storm drains, that 

work is incidental to the contract work.‖ 

 

May.  Use as appropriate instead of ―exercise its option to,‖ ―reserve the right to,‖ or similar 

phrases that describe a party’s prerogatives. 

 

Pay item.  As defined in Section 101, Definitions and Terms, for use after a contract is signed; 

use instead of ―contract item,‖ ―contract pay item,‖ or similar phrases. Before a contract is 

signed, use ―bid item.‖ 

 

Shall.  The use of the imperative mood should eliminate the need for ―shall.‖ Use ―will‖ to 

indicate something the department will execute. 

 

Shop drawings.  Use instead of ―working drawings‖ or ―shop or working drawings.‖ Shop and 

working drawings are the same thing, and the department calls them ―shop drawings.‖ 

 

Quantity vs. Amount.  Use ―quantity‖ for materials. Use ―amount‖ for money. 

 

That vs. Which.  ―That‖ and ―which‖ are often used as if they are interchangeable. They are not. 

―That‖ is properly used to introduce information or a phrase that is essential to the meaning 

of a sentence. ―Which‖ introduces information that is not essential to the meaning of a 

sentence. If, without changing the meaning of the sentence, a comma can be placed before 
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the word you want to use (―that‖ or ―which‖) the correct word is ―which.‖ If a comma would 

change the meaning, the correct word is ―that.‖ 

Hyphenation, Word Separation, and Standard Phrasing 

English changes over time and words that are commonly used together tend to migrate, first 

staying paired but separate, then finding frequent use with a linking hyphen, then joining 

eventually into a single word. 

 

It can be hard to know where in this progression a word pair or phrase may be. Some common 

combinations are shown below in the form they should be used in Standard Specifications. For 

further guidance, consult chapter 7, ―Spelling, Distinctive Treatment of Words, and 

Compounds,‖ in The Chicago Manual of Style or chapters 6 and 7, ―Compounding Rules‖ and 

―Compounding Examples,‖ in the United States Government Printing Office Style Manual, 2008. 

 

Hyphenated Words, Compound Words, Word 
Separation, and Standard Phrasing for use in 

Standard Specifications 

Instead of . . . Use . . . 

& and 

air entraining air-entraining 

attaining obtaining 

center line centerline 

cross section cross-section 

edge line edgeline 

guard rail guardrail 

high-early-strength high early strength 

pre-construction preconstruction 

right of way right-of-way 

steel wheel steel-wheel 

straight edge (the tool) straightedge 

sub-base subbase 

water reducing water-reducing  

work force workforce 

work site worksite 
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Cross-References 

Refer to sections or subsections of Standard Specifications by number and title. Capitalize the 

words ―section‖ and ―subsection‖ when making such a reference. Follow the number with a 

comma, and enclose the title between commas if reference is in the middle of the sentence. 

Example: The engineer will evaluate the gradation for chip seal aggregate in accordance with 

Subsection 113.1, Acceptance of Aggregate, and adjust payment accordingly. Follow title with a 

period if it ends the sentence. Example:  Cure precast concrete members in accordance with 

Subsection 513.4.13, Curing Concrete. 

 

Be as specific as necessary in making cross-references but no more so. 

 

Mailing Address for WYDOT 

Wyoming Department of Transportation 

5300 Bishop Blvd. 

Cheyenne, WY 82009-3340 
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11 Microsoft Office Word “Comments” 

General 

Writers and reviewers working on Standard Specifications may have comments or questions they 

would like addressed by others, or they may want to insert documentation for archival purposes. 

The easiest way to do this is by using Word’s ―comment‖ feature. All computer instructions in 

this Guide apply to Word 2007. 

 

Depending on a user’s needs, comments can be hidden completely or displayed in full in the 

right or left margin or below the text. Comments can be read and addressed directly on the 

screen, and they can be printed. 

 

Preparing the “Comments” Feature 

Comments are made and viewed under the Review tab, but the file must be in the Print Layout 

view to work with comments. In the View tab, ensure the Print Layout button is activated in the 

Document Views group. Do the following to see the comments in a file: 

 

1. Click the Review tab. In the Tracking box, click on the top down arrow, and choose 

either Final Showing Markup or Original Showing Markup. To hide the comments, 

choose either Final or Original. 

2. Click the Show Markup down arrow to choose the items that will be shown in the 

comments. Ensure the Comments box is checked. 

3. Also under the Show Markup arrow, Reviewers allows the user to choose any or all 

reviewers whose comments may be seen. Reviewers are each given a different color 

comment balloon and are shown by their names or initials. 

4. All comments are given a number and appear in numerical order. As new comments are 

added, comment numbers adjust so that they remain in numerical order. 

 

To change comment balloon color: 

 

1. In the Review tab, click on Track Changes, Change Tracking Options. 

2. Under Markup, click on the Comments dropdown arrow, and choose a new color from 

the color palette. 

 

To see a reviewer’s name and the date and time a comment was made or last updated, point the 

cursor to either the comment balloon or the commented text. 
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Using “Comments” 

To add a comment: 

1. Place the cursor in the text or highlight the text to be commented upon. 

2. In the Review tab, click on New Comment in the Comments group. Type comment in the 

bubble that appears. Comments can be endless, but it’s best to keep them short and to the 

point. 

 3. Click outside the comment bubble to end that comment. 

 

To edit an existing comment: 

1. Click in a comment bubble to edit that comment. 

2. Edit the comment as you would any Word text. Right-clicking on a comment bubble will 

allow the reviewer to change the comment font, font size, font color, and many other 

formatting attributes. 

3. Click outside the comment bubble once the editing is done. 

 

To reply to a comment: 

1. Click in or highlight the comment you want to reply to, and click on the New Comment 

button in the Comments group. 

2.  A new comment bubble will appear. Type in reply. 

 

To delete a comment: 

1. Right-click on the comment bubble and choose Delete from the dropdown menu to delete 

that comment bubble. 

2. Or, click on the comment bubble and then click on the Delete button in the Comments 

group. This gives the reviewer the option to delete this comment or all comments in the 

document. 

 

To print a document with or without comments: 

1. Click on the Windows button and go down to Print and then over to Print. 

2. In the Print dialog box, go down to the ―Print what‖ dropdown menu. To print the 

document without the comments, choose ―Document.‖ To print the document with the 

comments, choose ―Document showing markup.‖ 

3. Continue printing as usual. 
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12 Conversion Chart 

Use this chart to convert U.S. customary measurements to their SI (metric) equivalents. 

 

U.S. Customary SI 

1
/16 in 2 mm 

⅛ in 3 mm 

¼ in 6 mm 

5
/16 in 8 mm 

⅜  in 10 mm 

½ in 12 mm 

⅝ in 16 mm 

11
/16 in 17 mm 

⅞ in 22 mm 

1 in 25 mm 

1½ in 38 mm 

2 in 50 mm 

1 ft
2
 0.093 m

2
 

1 gal 3.8 L 

1 HP 0.8 Kw 

1000 BTU 1.06 MJ 

1 lb 0.45 kg 

(t °F - 32)/1.8 t °C 
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13 Specification Writer’s Checklist 

Use this checklist to verify that the many common problems in specification writing are 

addressed and corrected. Page numbers pertaining to the specific portions of this Guide are 

provided in parentheses. 

 

G Verify that references to numbers and titles of sections, subsections, forms, and figures 

from Standard Specifications are correct and are correctly capitalized and punctuated (pp. 

3, 25-26, 34-35). 

 

G Ensure that abbreviations and acronyms are accurate and current and are used only when 

appropriate (pp. 5-9). 

 

G Use correct symbols for measurement (pp. 12-13). 

 

G Use correct symbols for bid and pay units (p. 11). 

 

G Use correct mathematical signs and symbols (p. 15). 

 

G Do not use a period after a symbol, except at the end of a sentence (p. 14). 

 

G Punctuate lists consistently (pp. 28-30). 

 

G Avoid overcapitalization (pp. 25-26). 

 

G Format tables consistently (pp. 32-33). 

 

G Phrase sentences in the active voice (state the doer of the action) and imperative mood 

(give direct instruction to the contractor) (pp. 36-38). 

 

G Avoid unnecessary words and jargon (pp. 41-42). 

 

G Ensure materials and pay item lists are in alphabetical order (p. 40). 

 

G Ensure all decimal points in numbers are not ―naked‖ —have numerals on both sides (p. 

18). 

 

G Ensure U.S. customary measurements are followed by SI (metric) conversions in brackets 

(pp 11-13, 40), and ensure conversions are accurate (p. 48). 

 

G Ensure references to document titles are italicized (Standard Specifications, Materials 

Testing Manual, Survey Manual, etc.). 

 

G Use Word’s spell check feature to check for spelling errors. 

 


